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The purpose of this document is to demonstrate tools and basic software techniques for migrating 
existing hand sketch and technical drawings from traditional board methods of drafting to modern-day 
standard CAD software with low cost. It is assumed that the reader already has a working knowledge 
of traditional board drafting techniques, and is considering options to migrate these designs into CAD. 
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Forward  

Drafting By Hand using a Board 
 

 
Systematic technical drawing dates to the earliest 
records. Archeologists discovered this when cataloguing 
an unfinished Egyptian tomb. They saw for the first time 
that Ancient Egyptians preserved their trademark, rigid 
depiction of people by using a light, superimposed 
reference grid that assigned the human body to exact 
mathematical proportions. Although primitive, this 
system succeeded in maintaining a standard for 
Egyptian design for over 3000 years.  
 

 Implementation of systematic standards became one aspect of technical 
drawing that separated it from freehand art. For example, Ancient Greek 
architectural design was based largely on linear and Euclidean geometry, 
which greatly differentiated it from the absolute realism in organic form that 
sculpture of the same place and period strived to achieve. 
 
One important reason for this distinction between technical drawing and 
otherwise freehand “art” is related to the goals achieved by each discipline. 
Whereas freehand art is a much more expressive, cultural and interpretive 
purpose, technical drawing provides a practical depiction of a technical, 
scientific or mechanical concept to be implemented in real-world production - 
sometimes by third party having never met the original designer. An every-
day demonstration of how important this really is happens when we buy a 
furniture kit from IKEA and discover the instructions are still in Swedish. 

 
So we accept that it is more critical to correctly understand the exact meaning and intentions of a 
technical design than for other forms of drawing. In today’s industrial society, the ability to change 
entire designs quickly might also be important. Downstream communication with modern shop 
equipment, such as CNC cutters, or updating BOM lists for inventory are other important steps in 
taking an idea from concept to market. Computer Aided Drafting and Design, or 
CADD (since shortened to CAD), can meet all of these needs.  
 
It isn’t a surprise then that CAD has become the status quo. CAD systems are 
fast, accurate, flexible and now portable. CAD data can be shared 
simultaneously by multiple engineers around the world and sent directly to 
testing, tooling and manufacturing applications. But still, not all designers use 
CAD for themselves. Other companies are harvesting the growing market of 
just converting others’ hand drawings, sketches and board drafting to CAD 
data as a major part of business. 
 
Are you a designer, architect, draftsman, builder or engineer that doesn’t use CAD much now but are 
considering it more for the future? Are you confused by all the different technologies and programs 
that exist? Are you wondering how expensive or time consuming it might be to have many currently 
existing paper drawings converted to CAD? We hope that this free e-book helps you discover quick 
and affordable answers to some of those questions. 
 
Happy drafting! 
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Introduction to Digital Design 
 
 
Computers only understand two things: on and off. So computer language is called binary because it 
is built using a base two counting system. Base two simply means the amount of unique digits used in 
a system of counting. For example, our decimal system is a base ten - meaning that ten unique digits 
are used to create every other real number we use. Computers speak using a coded series of binary 
“ons” (“1”) and “offs” (“0”) called bits. Billions of them. In numerical terms this could look something 
like “001100101110…” 
 
CAD systems are all programmed to use different complex variations, or formats, of that one simple 
binary counting system. When someone converts our carefully crafted paper drawings to CAD they 
are “digitizing” them, or converting our drawn image to binary data that a computer program can easily 
display, edit, print, analyze or manufacture to any scale that computer equipment can be made for. 
 
There are thousands of binary formats which computers can save these resulting images of our 
drawings in. But most of these formats fall into two major categories – raster image files and vector 
image files. Understanding the difference between these two formats is basic to a successful CAD 
migration from paper drawings. 

 
Raster image files use a series of bits to “map” colors along a specified pixel 
matrix format. Each pixel describes information about the color and shade for 
one spot of the whole image matrix, much the way little dots work together to 
compose entire pictures on a newspaper. No underlying formulas or 
intelligence about intent of data is saved. Some formats save file space with 
compression algorithms which simplify how the image is stored, but basically 
computers see raster files as just some sequence of shades and colors. 
 

Vector graphic formats are “smarter” than raster formats. Vector 
formats are defined by a set of individual math and data objects 
with parameters. These objects are often called entities. In 
many cases, accurate vector data is much more useful, hence 
much more valuable, than unformulated raster data. A simple 
example of a vector format is called “XYZ” or “3D point data”. 
The XYZ point format specification defines one entity type: a 
point. An actual XYZ file uses this format by simply listing row 
after row of X, Y and Z parameters for every point entity in the 
file. Such data comes from real digitizing equipment for reverse 
engineering. Simple entities can also be combined into more 
complex collective entities, such as line entities into a square. 
 
So, one major difference between CAD programs (like progeSOFT’s “progeCAD” software) and other 
graphics drawing programs (like Microsoft’s “Paint”) is this type of file format used. CAD graphics are 
always vector math based graphics. On the other hand, even the very file extension suffix used to 
identify a Paint file - “.BMP” - actually stands for “BitMaP”. Paint is not a CAD program. 
 
A significant advantage to using computers to edit and store designs digitally is direct integration with 
other digital devices such as peripheral equipment. Peripheral equipment includes items directly 
attached to the host computer - like mice, printers, plotters, scanners and digitizers. Printers and 
plotters can make hundreds or thousands of copies of a drawing sent from a CAD system in the same 
time it would require a board draftsman to make one. Many today print using multiple colors and can 
print on a variety of media. A few can even print in 3D. 
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Another peripheral device that works as a computer’s eye is called a scanner. Small 2D scanners for 
flat images are quite common and inexpensive. But there also exist large format scanners for A0 and 
E size documents plus. Modern large format plotting equipment manufacturers (such as ROWE) often 
offer multifunction devices with integrated large format scanning. 

 
The ROWE High-Tech-CIS Scanners, combined with their “World First Double 
Light Technology” and Pro Logic+ Image Processing Technology, offer 
combined CCD and CIS Technologies in one scanning system. Such 
scanners are ideal for AEC, CAD and GIS applications as they have a greater 
ability to reproduce thin lines and edges more accurately when scanning 
hardcopy plans. Once such a device reads a paper drawing into memory, the 
data can be used for copying or sending to another computer as a file. 
 

A CMM (Coordinate Measuring Machine) can read real 3D object points within a certain cubic size. 
Full size fixed CMMs can be quite large and require professional maintenance. Mobile CMM 
equipment (commonly referred to as “3D digitizer” or “3D scanner”) has become more reliable in 
recent years. Popular names in such equipment are Romer, Faro and Microscibe. Recent 
technologies involve the use of lasers to scan a 3D item and create a complete computer model. 3D 
digitizers are commonly used for reverse engineering and quality control of products having complex 
shapes. This equipment is not generally used for simpler 2D raster and vector image conversion. 
 
A flatbed scanner which plugs into the USB port of a modern computer can cost less that 100 US 
dollars at a local electronics shop. It will allow you to place an A4 or A size sheet of paper having a 
small sketch or drawing on its glass surface. Many of these devices come with computer drivers which 
display a scan image on the computer’s screen as soon as some button is pressed. But many 2D 
optical scanners only deliver raster image data of their results. This means: although the picture on 
the screen may be right visually in our eyes, it has limited value as a form of computer data. 
 
OCR, or Optical Character Recognition, is a technique of parsing images for text in different 
languages. OCR software, such as the open source “libgocr” framework on Sourceforge 
(http://jocr.sourceforge.net), is useful for recognizing graphic text appearing in raster image files and 
returning what text data it sees for use in word processors. However, OCR applications only 
recognize text for certain languages and cannot normally see lines or other geometry. The software 
application that we would use for doing this will be described next.
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Raster and Vector Working Together 
 

 
Three concepts should be established at the beginning of this segment: 
 
1. Some CAD file formats have been extended to contain raster images and vice-versa as special 

objects, however the container format remains either raster or vector based. 
2. Conversion between raster and vector images is possible. There are multiple software programs 

available that can convert between formats with varying degrees of ease, speed and accuracy. 
3. It is far easier to create good raster images from CAD vector data than it is to derive reliable 

vector data from a raster image. 
 
The last concept should make sense because we already know that vector data holds both 
mathematical and conceptual information that raster data doesn’t. This segment will focus then on 
methods relevant to the first concept: that such conversion is even possible and ways to do it. 
progeCAD is an affordable tool from CADDIT (http://www.caddit.net) that can edit, convert, view and 
print AutoCAD (a common CAD program) files. We use progeCAD here because of its flexiblity, low 
cost and its bundled raster and vector tool set. 
 

First glimpse of progeCAD 2008 somewhat resembles a 
version of AutoCAD. Toolbars grouping similar icons can be 
placed where needed. progeCAD’s flexible command line 
also accepts many AutoLISP commands and scripts. The 
native file format for progeCAD is also AutoCAD DWG, for 
which it will edit and convert most versions thereof. 
 
Additional to most basic AutoCAD commands, progeCAD 
also offers additional tools for embedding and editing raster 
images. This makes our vector based binary DWG file format 
a container for raster objects inside. Why would we need this? 

 
First it is the easiest (but worst) way to save a scanned drawing 
into a CAD system. But a much better example reason was 
included with the progeCAD download distribution courtesy of 
BTicino Electronics Group of Milan, Italy. Their example file 
demonstrated embedding a complex electronic component’s 
raster image directly onto a vector schematic diagram. Such 
extra information can add value to drawings by offering 
improved component visualization to downstream engineering 
departments and with presentation to customers. Similar 
applications could be useful in architectural plans requiring a 
specific décor or council plans for a new development in a 
neighborhood of existing structures. 

 
Raster images are easy to embed using the progeCAD Professional 
2008 version. From its “Insert” menu, one simply clicks “Attach 
raster image…”. The user could alternatively type “_insertimage” in 
the progeCAD command line. A dialog box then opens asking the 
user to browse for the windows location of the external image he or 
she wishes to embed. A wide variety of raster image formats are 
supported by progeCAD for this function, including JPEG, JPG2000, 
TIFF, Landsat 7 FastL7A GIS imagery, ECW, ERDAS Imagine and 
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Military Elevation Data. Of course, progeCAD also supports basic Windows OLE2 API for object 
embedding, but the advantage of inserting data this way is the reference remains external. Therefore 
file size remains smaller and easier to update simply by changing one externally referenced image 
file. But there is also another advantage. 
 
progeCAD Professional includes a large set of raster image 
manipulation tools. Several are listed under the “Image” menu of 
progeCAD Professional. These include transparency settings, 
rectangular and polygonal image clip as well as ordering and 
management tools. We can change an attached image’s contrast 
and brightness using the “Image Management” window. This 
dialog also allows us to control the aspect ratio, cropping and 
orientation of the raster image. We can also call an external 
Windows application for further editing if required. 
 
But we can take raster images even further in progeCAD. We can convert raster directly to vector. 
Why would we want this? One reason is that precise geometry can then be sent directly to 
downstream FEA testing, estimating, prototyping and manufacturing applications. Vector entities can 
also be individually modified with what ever CAD functions you software offers. Vector entities are 
also useful as a reference for drawing other vector entities. 
 
Say for example we wanted to draw and additional breaker as one shown in our electronics image. 
Without existing vector geometry or written specification, we would be shooting in the dark as exact 
size and proportions. Sometimes even this is OK. But sometimes it isn’t. In some cases exact math 
data specifications are critical, such as in real world CNC tap and drill plans. In these cases we can 
sometimes recreate entire vector data sets from a decent raster photo and knowledge of just one (two 
or three are better) dimension in that photo. The results probably still wouldn’t be exact, but they might 
be more accurate than guesswork alone. If we converted our raster electronics photo into vector 
entities, creating a second set of those depicting our circuit breaker is much easier. The data might 
even be useful to Gerber or PCB autorouting software. This wouldn’t be the case with just a photo. 

 
progeCAD offers a third party tool for converting clean raster images 
directly into vector entities. We can launch this from progeCAD’s “Tools” 
menu by clicking “Raster to Vector”. A free version of the third party 
application Wintopo is launched. This is a basic application for refining 
and vectorizing raster image files. This version offers a few different 
logical algorithms for edge and boundary recognition to choose from. 
Wintopo freeware is sufficient for already sharp and clean hand sketch 
images in black and white, where despeckling, healing and pixel erosion 
techniques aren’t required.  

 
GIMP, a free tool we previously discussed, offers most of those options. GIMP 
can be downloaded from the internet at www.gimp.org and is available for 
almost any operating system – including Windows. This is good to have when 
images need cleaning up, or, preprocessing. GIMP offers several useful 
cropping, editing and refinement commands, many of which allow the user to 
preview any changes before accepting them and saving the “cleaned up” raster 
image to a new file for vector conversion. One useful GIMP command is 
despeckling – the removal of “dirt” or stray raster pixels and distortions. Vector 
translations always have a certain margin of error. Bold images without 
background or neighboring graphics vectorize better because image boundary 
to shape conversion uses contrast recognition. Usually: the bolder the image 
motif boundaries, the more reliable the raster to vector conversion. 
 

This outline of our 
electronics assembly 
was generated using 
GIMP software. 
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Another free tool for raster to vector 
conversion is Autotrace. Autotrace was 
developed primarily for GNU Linux systems, 
but will also run with Windows systems under 
DJGPP (binary is available from CADDIT 
website www.caddit.net). This is a command 
line tool that doesn’t offer previews and is 
therefore likely to be difficult for many to use. 
It also requires much more time in analyzing 
complex graphics, and initial results can be 
vary depending on the algorithm used. For 
example, the following DOS command line - 
 
autotrace -despeckle-level 2 -input-format TIFF -

line-threshold 2 -report-progress -output-format 

dxf Quadro-elettrico.bmp > Quadro-elettrico.dxf  

 

- will convert our electronics image into a 15 megabyte file of DXF vector entity patterns as seen here. 
The specific vector information we need is all present – somewhere. But further refinement in our 
conversion parameters might be needed before this work added any real value. There are also a 
number of commercial graphics applications that offer raster to vector conversion, like Serif DrawPlus’ 
own “AutoTrace” command. Rather than consuming several chapters to discuss a detailed approach 
for using these applications, we will describe briefly the principles involved and resources to help get 
you started on your own. As stated before, it is far easier to create good raster images from CAD 
vector data than it is to derive reliable vector data from a raster image. 
 
There are several easy ways to create a raster picture back from 
CAD data. The Microsoft Windows operating system offers 
application bitmap clipboard support. Just by pressing ALT-PrtSc 
you can capture the bitmap of any window – including CAD. 
Otherwise, using the PrtScn key alone (without the ALT key) will 
capture the whole desktop. Then using a raster editing application 
like GIMP, we can use the CTRL-V key combination to paste what 
we captured into a picture and save that as some raster file. 
 
Additionally, progeCAD Professional can print out refined JPEG and 
PDF files direct from any drawing using the bundled “progeSOFT 
JPG” and “progeSOFT PDF” wizards that come with the program. These wizards are included in the 
download version of progeCAD Professional from CADDIT and offer reliable results. 
 
Although it is possible to convert hand drawn designs into CAD, doing so can be tricky and time 
consuming. It can also be quite expensive. It is a far better policy to use CAD from the very beginning 
of detailed design work and print out needed hardcopies afterward. This will be discussed next. 
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Editing Designs in CAD 

 
This tutorial is designed to show you how to use some of the basic operations of progeCAD. This 
tutorial will cover some of the basic Draw commands fundamental to using all CAD packages as well 
as explain to you how to use the interface and basic menu functions. The rest will be covered in future 
tutorials. This eBook only covers entity creation. A continuation of this tutorial is available on 
CADDIT.net at http://www.caddit.net/progecad/tutorial/ which covers editing, trimming, blocks and 
more. 

  

Basic File Operation 
  
In this section we'll run through the basic file operations within progeCAD. These include creating a 
new drawing, opening a previously saved drawing, saving your current drawing and printing your 
drawing. There are a few ways that these operations can be done. A very easy way is by using the 
File drop down menu. Another approach is to use the Standard toolbar and finally certain commands 
can be activated by using the keyboard. 

 

Creating A New Drawing 
                                                                                                
To start a new drawing all you have to do is click on the New icon on the standard toolbar, 
alternatively you can select "New.." from the File drop down menu or use <Ctrl> + 'N'. The window 
that you see below will appear. Simply select the template you would like to use and click OK. 
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Opening A Saved Drawing 
                                                                                                                       
To open a previously saved drawing all you have to do is click on the Open icon on the standard 
toolbar, alternatively you can select "Open.." from the File drop down menu or use <Ctrl> + 'O'. Then 
simply select find the drawing that you want to open and click Open. 

 

 
  

Saving your Drawing 
                                                                                                                              
To save the drawing you are working on all you have to do is click on the Save icon on the standard 
toolbar, alternatively you can select "Save" from the File drop down menu or use <Ctrl> + 'S'.  Please 
note that if you are working on a previously opened file that this will simply save the changes that you 
have made. To save to a new drawing file you will need to select "Save As" from the "File" drop down 
menu. You should then see the window displayed below, then simply select the location you would 
like to save the drawing to and give it a name, when you are happy that you have it in the right place 
with the right name then click "Save". 
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Printing your Drawing 
                                                                                                                              
To print the drawing you are working on all you have to do is click on the Print icon on the standard 
toolbar, alternatively you can select "Print.." from the File drop down menu or use <Ctrl> + 'P'. The 
window below will appear. Select the printer that you would like to output the drawing to and verify 
that your settings are correct. When you are happy with these then just click print, otherwise make the 
appropriate adjustments. Please note that it is always recommended that you check all your output 
settings before you hit "Print". 
  

 



CADDIT CAD CAM Software and Services 

http://www.caddit.net , Blog at http://cadcam3d.blogspot.com 
PO Box 553 Liverpool, NSW 1871 Australia 

RSS Newsfeed: http://feeds.feedburner.com/CadditCadCamCncBlog 
 
 
 
 

 
 

CADDIT Guide to Convert Board Drafting and Hand Sketch Designs to CAD 
 
CADDIT - 4 - 9/2/2008 

  

Draw Commands and Properties 
  

 
  

             
    The Draw commands can be used to create new objects such as lines and 
circles. Most IntelliCad drawings are composed purely and simply from these basic 
components or entities.The sections below cover the most frequently used Draw 
commands such as Line, Polyline and Circle as well as the more advanced 
commands like Multiline and Multiline Style. In common with most IntelliCad 
commands, the Draw commands can be started in a number of ways. Command 
names or short-cuts can be entered at the keyboard, see below. Commands can 
be started from the Insert pull-down menu, shown on the left or from the Draw 
toolbar, seen above. The method that you choose to use is entirely up to you and 
what you are comfortable with. In time you will find that each method has its pros 
and cons and that one method may be faster for certain tasks than others. 

The picture you see to your right is the Properties box. This box allows you to edit 
attributes to a specific entity or multiple entities depending on the situation. These 
include: Color · Elevation · Layer · LType · ltScale · Thickness. 
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BASIC DRAWING & GEOMETRY - PART 1 
  
  

Lines 
  
Lines are the most simple of IntelliCAD objects. With the Line command you can draw a simple line 
from one point to another. 
  

Toolbar Draw 
 

Pull-down Insert→Line 

Keyboard LINE short-cut L 
 
When you select the first point and move the cross-hairs to the location of the second point you will see 
a rubber band line which shows you where the line will be drawn when the second point is picked. Line 
objects have two ends (the first point and the last point). You can continue picking points and 
IntelliCAD will draw a straight line between each picked point and the previous point. Each line 
segment drawn is a separate object and can be moved or erased as required. To end this command, 
just hit the � key on the keyboard or right click 

  
Command Sequence Example 
  
Command : _LINE  
ENTER to use last point/Follow/<Start of line>:  
Angle/Length/<End point>:  
Angle/Length/Follow/Undo/<End point>: 
  

                

Here is an example of a line being drawn.  
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Infinite Lines 

The Infinite Line command creates a line of infinite length which passes through two picked points. 
Infinite lines are very useful for creating construction frameworks or grids within which to design. 

Toolbar Draw 
 

Pull-down Insert →Infinite Line 

Keyboard INFLINE short-cut XL 

   
You may notice that there are a number of options with this command. For example, the "Hor" and 
"Ver" options can be used to draw construction lines that are truly horizontal or vertical. In both these 
cases, only a single pick point is required because the direction of the line is predetermined. To use a 
command option, simply enter the capitalised part of the option name at the command prompt. Follow 
the command sequence below to see how you would draw a construction line using the Horizontal 
option.To end this command, just hit the �  key on the keyboard or right click. 
  
Command Sequence Example 

  
Command : INFLINE 
Infinite line:  Bisect/Horizontal/Vertical/Angle/Parallel/<Point along 
Line>:  
Direction: 
  

 



CADDIT CAD CAM Software and Services 

http://www.caddit.net , Blog at http://cadcam3d.blogspot.com 
PO Box 553 Liverpool, NSW 1871 Australia 

RSS Newsfeed: http://feeds.feedburner.com/CadditCadCamCncBlog 
 
 
 
 

 
 

CADDIT Guide to Convert Board Drafting and Hand Sketch Designs to CAD 
 
CADDIT - 7 - 9/2/2008 

 
  

Polyline 
  
Polylines are different than lines in that they are more complex objects. A single polyline can be 
composed of a number of straight-line or arc segments. Polylines can also be given line widths to 
make them appear solid. 
  

Toolbar Draw 
 

Pull-down Insert→Polyline 

Keyboard PLINE short-cut PL 

  
The Polyline or Pline command is similar to the line command except that the resulting object may be 
composed of a number of segments which form a single object. In addition to the two ends a polyline 
is said to have vertices (singular vertex) where intermediate line segments join. In practice the 
Polyline command works in the same way as the Line command allowing you to pick as many points 
as you like. Again, just hit Enter to end. As with the Line command, you also have the option to 
automatically close a polyline end to end. To do this, type C to use the close option instead of hitting 
� . Follow the command sequence below to see how this works. 
  
Command Sequence Example 
  
Command : PLINE 
Start of polyline: 
Arc/Distance/Halfwidth/Width/<Next point>: 
Arc/Distance/Follow/Halfwidth/Width/Undo/<Next point>: 
Arc/Close/Distance/Follow/Halfwidth/Width/Undo/<Next point>: 
Arc/Close/Distance/Follow/Halfwidth/Width/Undo/<Next point>: 
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Splines 
  
The Spline command creates a type of spline known as a nonuniform rational B-spline, or NURBS for 
short. A spline is a smooth curve that is fitted along a number of control points. The Fit Tolerance 
option can be used to control how closely the spline conforms to control points. A low tolerance value 
causes the spline to form close to the control points. A tolerance of 0 forces the spline to pass through 
the control points. 

  

Toolbar Draw 
 

Pull-down Insert→Spline 

Keyboard SPLINE short-cut SPL 

  
Splines can be edited after they have been created using the SPLINEDIT command. Using this 
command, you can change the tolerance, add more control points move control points and add 
splines, amongst other things. 
  
Command Sequence Example 
  
Command : SPLINE 
First point for spline: 
Second point: 
Close/Fit Tolerance/ <Next point>: 
Close/Fit tolerance/<Next point>:  
Close/Fit tolerance/<Next point>:  
Close/Fit tolerance/<Next point>:  
Select starting tangent point:  
Enter tangent for ending point:  
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Rectangle Tool 
  
The Rectangle command is used to draw a rectangle whose sides are vertical and horizontal. The 
position and size of the rectangle are defined by picking two diagonal corners. 
  

Toolbar Draw 
 

Pull-down Insert→Rectangle 

Keyboard RECTANGLE short-cuts REC, RECTANG 
  
The Rectangle command also has a number of options. Width works in the same way as for the 
Polyline command. The Chamfer and Fillet options have the same effect as the Chamfer and Fillet 
commands, However we will look at these later. Elevation and Thickness are 3D options.Notice that, 
instead of picking a second point to draw the rectangle, you have the option of entering dimensions. 
  
Command Sequence Example 
  
Command : RECTANGLE 
Chamfer/Elevation/Fillet/Rotated/Square/Thickness/Width/<Select first 
corner of rectangle>:  
Other corner of rectangle: 
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Polygon 
  
The Polygon command can be used to draw any regular polygon from 3 sides up to 1024 sides. This 
command requires four inputs from the user, the number of sides, a pick point for the centre of the 
polygon, whether you want the polygon inscribed or circumscribed and then a pick point which 
determines both the radius of this imaginary circle and the orientation of the polygon. The polygon 
command creates a closed polyline in the shape of the required polygon. 
  

Toolbar Draw 
 

Pull-down Insert→Polygon 

Keyboard POLYGON short-cut POL 
  
This command also allows you to define the polygon by entering the length of a side using the Edge 
option. You can also control the size of the polygon by entering an exact radius for the circle. 
  
Command Sequence Example 
  
Command : _POLYGON  
Polygon:  Multiple/Width of line/<Number of sides> <5>: 5 
Specify by:  Edge/<Center of polygon>: _E  
First endpoint of edge:  
Second endpoint of edge: 
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Circles & Arcs 
  
Along with Line and Polyline, the Circle command is probably one of the most frequently used. 
Fortunately it is also one of the simplest. However, in common with the other commands in this 
section there are a number of options that can help you construct just the circle you need. Most of 
these options are self explanatory but in some cases it can be quite confusing. The Circle command, 
for example, offers 6 ways to create a circle, while the Arc command offers 10 different methods for 
drawing an arc. The sections below concentrate mainly on the default options but feel free to 
experiment. 
  
Arc 
  
The Arc command allows you to draw an arc of a circle. There are numerous ways to define an arc, 
the default method uses three pick points, a start point, a second point and an end point. Using this 
method, the drawn arc will start at the first pick point, pass through the second point and end at the 
third point. Once you have mastered the default method try some of the others. You may, for example 
need to draw an arc with a specific radius. All of the Arc command options are available from the pull-
down menu. 
  

Toolbar Draw 
 

Pull-down Insert→Arc 

Keyboard ARC short-cut A 

  
 It is also possible to create an arc by trimming a circle object. In practice, many arcs are actually 
created this way. 
  
Command Sequence Example 
  
Command : _ARC  
ENTER to use last point/Center/Follow/<Start of arc>:  
Angle/Center/Direction/End/Radius/<Second point>:  
End point: 
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Circle 
  
The Circle command is used to draw circles. There are a number of ways you can define the circle. 
The default method is to pick the centre point and then to either pick a second point on the 
circumference of the circle or enter the circle radius at the keyboard. 
  

Toolbar Draw 
 

Pull-down Insert→Circle 

Keyboard CIRCLE short-cut C 

  
Command Sequence Example 
  
Command : _CIRCLE  
2Point/3Point/RadTanTan/Arc/Multiple/<Center of circle>: _2P  
First point on diameter:  
Second point on diameter: 
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Continuation of this tutorial is available on CADDIT.net: 
http://www.caddit.net/progecad/tutorial/ 
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Benefits of CAD over Board Drafting 

 
1. CAD & Digital vector design offers a lot more flexibility. Data can be sent directly to other digital 
applications, like a CNC cutter for a car decal or a stress testing program like FEA. 3D models go 
further in offering virtual computer simulation of moving parts. If errors in the design are found, a small 
change is made and the test is run again. 
 
2. CAD is cheaper and more environmentally friendly. Rather than wasting reams of paper drafting 
modifications, everything is stored on a computer. True, it consumes some electric, but hand drafting 
consumes hours more human power, not to mention the weight and cost of large boards, paper, 
templates and a drafting machine. 
 
3. CAD is more secure. Data can be encrypted. Paper drawings aren't (normally). 
 
4. CAD is far more reliable and accurate. Board draftsmen often derive measurements by hand. CAD 
dimensions are calculated electronically to a desired level of accuracy. 
 
5. CAD is faster. For example, template objects still need to be traced by hand on the board, but they 
can be inserted scaled and positioned by just a few mouse clicks in CAD. But CAD really shines when 
it comes time to make modifications of an existing drawing. Anyone who says the board is faster just 
never bothered to learn CAD. 
 
6. It makes team development easier. The same drawing can be referenced and changed by an entire 
department. 
 
7. CAD data doesn't degrade, fade, burn or get yellow. Well not normally. 
 
Contrary to rumors, there are CAD programs that run on any modern computer, even the low end 
Celeron chip will run a simple CAD application. Also, there are many free CAD programs for personal 
use, like progeCAD Smart! 
 
That all being said, hand drawing will always have its place. I find it often easier to think up the original 
concept on the board just drawing a few lines until I am happy with the idea hidden in the chicken 
scratch that only I can read, then I move to to CAD for concept development, finalization, printing, 
collaboration and any CAM prototyping that needs done. In reality, this is probably how most 
engineers work today. 
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